
ADVANCED VIDEO EDITING WITH MPEG VIDEO WIZARD.

Start the program.

TO EDIT OUT COMMERCIALS:

Click on the ‘Files’ tab and then the ‘Open’ icon.  Browse to the file you want to edit. For the purpose of this 
tutorial I will be editing a program stream from Digital TV called ‘Johnny Cash’.

A thumbnail of the file will appear in the project window on the left.  To start editing, drag the icon to the ‘Input’ 
window.



Using the keyboard is the fastest way to edit. Slide the progress bar along till you get close to the point where you
want to mark a starting point for a selection. You can use the left and right arrow keys to move slowly to locate
the starting frame. The up and down arrow keys jump through in large steps. You can press d to start playing and
again to pause. Press s once to speed up the play and again to go super fast, once more to return to normal play.
This also applies to the navigation with the arrow keys so when you have marked the start press s once to change
to fast forward or twice to super fast forward and then use the right arrow key to move very quickly to the end of
the area where you want to put a mark out. A short key of the left arrow key will take you back one frame at a
time as you will mostly zoom past the spot where you want to finish. If you have been zooming super fast just
press the s key again and you can move back at normal speed to fine tune the selection.

When you have located the start frame press I (for in). Use the same procedure to find the last frame and press o
(for out). You have now marked the in and out frames to capture a clip (say a song in a musical video). Press
Ctrl+e to extract the clip. The clip will show in the Clips window on the left. This is non-destructive editing, the
original file remains the same. If you are selecting songs from a music video it is best to save each clip as you
extract it. See below for details.

Proceed through the entire video and select and extract all the clips to make your new edited version. If it is a
movie you will be selecting the bits between the ads.

To put them all together into one file simply drag each clip (starting from the first one) to the top timeline below
the input and output windows (the one with the movie camera icon). Simply push them together to join them.
You can play each or all of the clips in the output window once they are on the timeline. It is a good idea to check



the finish and start of each clip to make sure you have them in order (especially if it is a movie that you have cut
the ads out of). For movies it is a good idea to place each clip on the time line as you extract them and you will
not have any out of order.

For a musical DVD you may want to make a transition effect between each song. Click on the Effect tab, then
select Filter, then select 2D. The Fade filter is the best. This fades both the audio and video so the next clip
slightly overlaps the previous and makes a very professional job. Click and drag the Fade icon to the junction of
the two clips that you want the filter to apply to.

All you have to do now is save the file. If you are making it from a Digital TV transport stream (.tp file in the case
of the Fusion card) it needs to be ‘demuxed’ first with the MPG Demultiplexer tool in Tools menu.
You can select ‘DVD Pal or DVD NTSC if that is your television type’ as the file type but this will take quite a 
long time as it has to be re-encoded from 15,000 kbs to 6000 kbs. I find that leaving the file at 15,000 kbs is no
problem, jut tell TMPGEnc DVD Author to ignore it and keep going. You should set your TV card to save the TV
programs in MPG format and then demuxing is not required. Do not save High Definition TV programs as
these are not DVD compatible and cannot be made so.



You can take a huge shortcut byselecting ‘Automatic’ in the ‘Save as type’ selection and this will not re-encode
the file. It will remain at the 15,000 kbs bit-rate which even though not strictly DVD compatible, 99% of DVD
players will play it.

If you click on ‘Details’ it will show you how much (if any) of the file will be re-encoded. The more it is re-
encoded the longer it will take.

Select DVD NTSC, if that is your
television type.

If you have selected DVD NTSC
the Video information will show:
MPEG-2, 720x480, 29.97 FPS



Another way to do it is to Demultiplex and Remultiplex the file first. A transport stream from Digital TV
contains a lot of data that is not compatible with a DVD MPG2 file. This operation strips off all the extra data and
leaves a DVD compliant file (well almost anyway).

MPEG Video Wizard has a small floating window with a number of tools.  Click on the ‘Spanner’ and select 
MPEG Systems DeMultiplexer.

Select the input file with the button marked …. On the right side of the top window where it says ‘File Name’.  
The Video and Audio output files will automatically be named the same as the original file. All you have to do
then is click on Save.



Once the file has been DeMultiplexed you can now ReMultiplex it.   Go back to the ‘Spanner’ icon, click on it 
and select ‘MPEG Systems Multiplexer‘.  You now have to select the Video and Audio files that were just 
created. They will have the same name, except the extensions will be .mpv (video) and .mpa (audio). You can
leave the output file the same name as it will now be saved with the file ending of .mpg. Just click save and the
mpg file will be created. Be sure to tick VBR (variable bit rate) box under Advanced.

You can now either load it back into MPEG Video Wizard and cut out individual songs or remove ads. If it is a
movie it is easier to go straight to TMPGAuthor.

Even though this file will have a variable bit-rate of 15,000 kbs and not strictly DVD compatible I have not found
a DVD player that will complain about it. The file can be loaded into TMPGAuthor (it will complain that it is not
a compliant DVD file, but just click ‘Ignore’) and create a DVD as described in the ‘How to Transfer Video
Tapes into DVDs’ tutorial, included below.  By not converting the file to 6000 kbs it saves a huge amount of time.  
In reality the file is probably not anywhere near the 15,000 kps bit-rate as re-encoding it does not make it any
smaller. When you create the VOB files it will complain again about the bit-rate, just click ‘Ignore’.



USING TmpGenc AUTHOR TO EDIT THE VIDEO and create VOB files:

Start TmpGenc Author, click on ‘Create New Project’,  if it is a movie you need only one track.  Right click on
‘untitled track’ in the left window, click ‘Rename’ and type in a name (the name of the movie), hit Enter.
Now click on ‘Add file’ and select the MPEG file and click ‘Open’.  To recognize files with the MPEG ending, 
select ‘All files’, otherwise it looks for files ending in mpg.  When it is imported, click  ‘OK’.
It will show the length of the proposed DVD and the red section shows how much too big it is.
Click on ‘Options’ and select ‘Save as’ and give the project a name.

Trimming the start and end.
Click on ‘Edit’ then click on ‘Chapter cut edit’.  You will now see the video file in a preview window with 
frames below. These are not every frame, but the ones you can mark for editing, about 1 in 3 to 1 in 5. The frame
that you can mark is highlighted in red. Press the down arrow key to fast forward to the frame you want to start
on, if you go too far, use the up arrow key to go back.  When you have found the correct frame click on ‘Set as
start frame’.  Move the slider quickly to the end ofthe file, wait for the frame view to catch up then use the up
arrow key to move back to the end frame. If you have let it run quite a while past the end, use the slider to find the



approximate frame.  When it is selected, click on ‘Set as end frame’.  Click on ‘Edit menu’ and click on ‘Cut all
but currently selected range’.  You will be asked if you really want to, say Yes. Click on OK.

Editing out Ads.
Click on ‘Edit’ then click on ‘Chapter cut edit’.  You will now see the video file in a preview window with
frames below. These are not every frame, but the ones you can mark for editing, about 1 in 3 to 1 in 5. The frame
that you can mark is highlighted in red. Select the slider control with the mouse by clicking and holding down the
left button. Slide it to the right with a very smooth and steady motion and the movie will flash past very fast. If
you go too fast it will stall and slow down. It takes a bit of practice to be able to do it quickly. When you see an ad
lift your finger. Try to move it very slowly backwards to get near the start of the ad, after waiting for the frame
view to catch up. Use the up/down arrow keys to move fast forward and back to select the start of the fade before
the ad. When it is red, click on ‘Set as start frame’, move the slider slowly to find the end of the ad, adjust to the
very first frame after the ad with the up/down arrow keys and click on ‘Set as end frame’.  Click on ‘Cut’, you 
will be asked if you want to cut the currently selected range, click ‘OK’.  Keep going till you have found and cut
all the ads. They are never the same distance apart throughout the movie.

REINCODING THE AUDIO.
If you have set the audio to LPCM audio (uncompressed) (in the video recording program, which you should not
do as MPEG audio is fine) the audio section is very large.  If your file is over 4.4Gb, click on ‘Settings’ in the left 
window, in the audio section at the bottom, change the audio from LPCM to ‘MPEG-1 Audio layer 1’ or “AC-3” 
(if you have the required plugin). The default bit rate is 384 kbps (very high quality) and there is not much use
reducing this. You can go down to 224 kbps if that will make it fit. For song video clips the audio it should be at
least 256. You can fit about 30-35 songs on a DVD at this setting. If necessary you can reduce the bit rate setting
to in WinDVDR to 4500 to make your recordings. This still gives good results as it is actually about 7000.

When you DeMultiplex and then ReMultiplex a file the audio is usually left at whatever the original type was.
.
Note from Recording Video Tapes:
If you notice audio/video sync problems (sound not in time with video) you fix this in MPG Video Wizard, it
cannot be fixed in the authoring program. When a video is in the editing window right click on the preview screen
and select audio then shift. A small window will appear with a slider. The time is in milliseconds and by moving
it back and forwards while playing the video you will be able to re sync the video. When you have it correct drag
the video from the preview image to the time line and save as explained above. Sync problems are not common
but can occur when copying an old video tape where the sync signal is a bit weak. If it happens often then your
processor is probably too slow to record properly in MPG format.



If you are using the NTSC video system the video information will show:
720x480 pixel, 29.97 fps, NTSC.

Creating the Menu.
Click on ‘Create Menu’.  Click on ‘Title’ and type in the name of the movie (if you have not already named it).
Click ‘Select Track’ in the left window, you will see a thumbnail with the name of the track beside it.  If you 
renamed the untitled track to the movie name this should be OK.
Double click the thumbnail and select a frame to be shown (if the first frame is not OK).
Click ‘Track One Menu’ in the left window.  The track name should be OK.  If you were making video song 
clips you may want to split them up into several tracks, one for each artist, so this is where you would have
different track names.

Click on ‘Select Chapter’.  Each time you cut out an ad a new chapter is created.  Double click the thumbnails to 
select a frame.  Do this for all of them.  Don’t take too much time over this as they are too small to see on the TV 
anyway.



You may want to simplify things by eliminating the main menu.  Under menu settings select ‘Track menu only”.  
For a commercial movie copied from a tape there will be only one chapter, so simply name this ‘Play’.

Go to Options and save the project when you have checked that you have all the menu items correct. There are
various menu templates available and you may not like the one shown here. For music videos I use one that has 8
chapters on each page.

Under ‘Display menu settings’ select ‘General’ and you can change how the tracks are played. I usually have
‘Play all tracks’ and ‘Play next track’ selected. This will automatically start playing the movie when you insert 
the DVD and if you have created several tracks, say for different artists on a music DVD, all tracks will play
without having to go back to the menu and select them.

Go to ‘Output’ and make sure ‘Create DVD folder’ is checked.  Browse to select your output folder.  I always 
use the same ‘c:\aamovies’ folder.  The program will create a folder called ‘Volume1’ (or 2,3 etc if you do not 
delete the Volume1 folder when you have finished) with the VOB files. If your movie is too big to fit on a DVD it
will complain, just select ‘Ignore’.



Sometimes T….author over estimates the file sizes.  If it appears to be only a small amount over, load it into DVD
Shrink and if it says the files will be saved at 100% of original size then it will fit on a DVD and need not be
shrunk. Just go straight to Nero.

You can burn a dvd from TmpGenc Author, but I had a couple of duds and do not recommend it. Nero is as
simple as falling off a log and the DVDs are rock solid.

SHRINKING THE VOB FILES TO 4.4Gb.
If the files are still too large, open DVD Shrink 3.13. or 3.17 (download the latest from time to time– it’s Free!)

When first starting DVDShrink go to edit-settings and set the DVD size to ‘Custom’ and change the 4468Gb to 
4400Gb.  Some DVD’s play up on the outer track and this will make sure the recording finishes in from the edge.

Click on ‘open files’ (if you want to rip a commercial DVD select ‘Open Disk’) and locate the VIDEO-
TS folder in the ‘Volume1’ folder that T ….. Author created. Click OK.

The files will be imported and a preview will be available.



Select ‘Automatic’ in the compression settings.  It will show you how much it will be compressed. 80% means
the files will be 80% of the original size, compressed 20%.

Click on ‘Backup’, then the ‘Target Device’ tab.  Select ‘Hard Disk Folder’ for the device.  Browse to the folder 
you want the compressed files to be saved in.  I use a folder called ‘Shrink’ in the ‘aamovies’ folder.  Click on the 
‘Backup options’ tab and make sure ‘Perform Deep Analysis’ and ‘Compress video with high quality
adaptive error compensation’ are selected.  ‘Maximum smoothness’ is the best setting for the error
compensation.  Under ‘DVD Region’ select ‘Region Free’ which is the default.
Click ‘OK’ and the shrinking will begin.  You can also burn the DVD from DVD Shrink, but again I have found 
errors on some DVDs burnt this way. USE NERO!



BURNING THE DVD MOVIE

Insert a blank DVD, Start Nero Express*, make sure your DVD writer is the selected device.  Click on ‘DVD-
Video files’, click on ‘Add’ and browse to the ‘Volume1’ (or Shrink) folder and select both folders ‘ 
AUDIO_TS’ AND ‘VIDEO_TS’, Click on ‘Add’ then click on ‘Finished’. Click ‘Next’. Type in a name for the 
DVD (Nero only allows 16 characters for the name) and press TAB to get down to the speed setting. Set the burn
speed to match the blank DVD ( if you have an 8 speedburner and 4X disks).  Click ‘Burn’.

*  If you have the ‘Nero Smart Start’ set to run when you start Nero, get rid of it! Create a shortcut on the desktop
or in the special recording folder (if you have made one) to Nero.exe in the following folder: \Program
Files\Ahead\Nero\. If you cannot see the file extensions in My Computer or Windows Explorer do the following:-
Right click on the start button, select ‘Explore’ – click on ‘Tools’ then ‘Folder Options’, click on the ‘View’ tab, 
scroll down to ‘Hide extensions for known file types’ and untick the box.  Click on ‘Apply’ then ‘OK’.

Do not stick labels on your DVDs, it takes only a tiny bit of wobble to upset the player. If you want fancy labels
buy a printer that will print on printable media. NEVER USE STICK ON LABELS.

If your DVD player has trouble reading the disks try burning at a slower speed, and if you still have trouble change
your brand of disks. Some burners do not do well with some brands of disks. Look on your disk packet. The Ul-
Tran brand that I have used a lot of has various firmware updates listed that are required for the various brands of
burners. UL-TRAN “Children Series” (Previosly UL-TRAN Premium) work by for the best on my Pioneer AO6
burner (only about 1 dud in a 100) and the UL-TRAN printable ones not so well, but they work perfectly on the
AO7 that I use for data backup in my main computer. I have recently started using Ritek printable disks and find
them very good in both the A06 and the A07 burners. Of the high priced brands Verbatum (very expensive but
very good) and BenQ (made by Sony) are the pick. UL_TRAN AND RITEK work extremely well with Pioneer
burners.

The only way you can tell if you have a dud disk is to watch the movie on your DVD player. If you get a bit past
halfway and the image starts to break up from time to time, this is a dud disk. I found Laser disks very bad in my
burners and did not get one good one out of ten.

I will stick with Ritek 8X disks as they are cheap, readily available and so far no duds!



FIXING UP AN AUDIO/VIDEO SYNC PROBLEM:

Open MPEG Video Wizard–
Click on the ‘Files’ tab and then the ‘Open’ icon.  Browse to the file you want to edit. For the purpose of this 
tutorial I will be editing a file called ‘Big River’.

A thumbnailof the file will appear in the project window on the left.  To start editing, drag the icon to the ‘Input’ 
window.

Pause the file from playing, right click on the image in the input window, select ‘audio’ then select ‘shift’.  A 
small window will pop up called ‘Audio Shift’.  There are two buttons on the window, one marked ‘video’ and 
the other shows the amount of shift. When you start it will be set at 0. Start playing the song and move the slider
back or forward till the audio is in sync with the video. When it is OK, pause the video, right click on it and select
‘Add to Clips’.  The video will now show in the clips window on the left.  Drag the clip to the timeline and save it 
as before.  Be sure to select ‘automatic’ so it will not be re-encoded.



To check that the audio and video is now in sync play the file in your media player. I highly recommend the free
one VLC, available from http://www.videolan.org/vlc/ .

IMPROVE THE SOUND QUALITY OF A MUSIC DVD.

For this you will need Cool Edit Pro 2 or Adobe Audition 1.5.

Open Cool Edit or Audition– select ‘Extract audio from video’ then browse to the video file and double click on 
it. The audio file will appear in the editing window and you can do any improvements such as boost bass, mid or
treble, amplify it, fade in or out but NEVER cut any of it. When you have finished editing it just save it as a
wave (.wav) file. Open MPG video wizard then use the Demultiplexer tool to separate the video from the audio, if
you like you can tick Create a new project on the time line with the output files. When the files appear on the
time line, click on the audio file and delete it. Then open the wave file you created in Cool Edit/Adobe Audition
and drag it onto the audio section of the time line where the original one was. Just check that the audio and video
is in sync and save it as before. If the av-sync is out you will then have to reopen it and adjust this problem and
save it again. This will clutter up you hard disk with large files so be sure to delete them (and not into the rubbish
bin) as soon as possible. To permanently delete files hold down the shift key while you press delete. But be
warned, they are not recoverable when you do this.

It will look like the image below.



This is a classical ‘dud’ file with very poor audio where one channel (the left one) is very soft. To fix this use the 
amplify tool. To select only the left channel click near the top of this channel. Click on Effects then Amplitude
then select Amplify/Fade. One this soft would need at least 15 db boost. Then play the result, if it sounds bad
you can replace the left channel with the right one and create dual channel mono which will sound very good. To
do this click in the center of the window to activate both channels then in the Amplitude window select Channel
Mixer. Choose Both equals right and click OK. Most videos will have well balanced channels and this will not
be necessary.



You can now do almost anything you like with the audio.  To increase the volume level click on ‘effects’ move to 
‘Amplitude’ and out to ‘Amplify/fade’.  The audio is very low, if this was a track imported from an audio CD the 
green area showing the actual signal would almost fill the black space. We will increase the level by 6 db. Click
on ‘6 db Boost’ in the effects window –see below.



Click OK and it will be done.

The file will now look like this:-



With good quality audio you should be able to see a lot of variation in the spikes and troughs on the screen. If it is
almost flat it means the audio has been compressed and is of low quality as it has very little dynamic range.

You can check the sound at any time by clicking the play button.

Now to boost the bass you need to create a bass boost filter.  Click on ‘Effects’, move down to ‘Filters’ and select 
‘fft filter’.  A good filter to start with is ‘Kill the Sub Harmonics’. Click on this one and it will show in the 
window. Click on ‘Logarithmic’ near the top, then click the ‘Flat’ button. The filter will now show as a straight
line from 0 db to about–15 db. Click on the small white square at the left end of the line and drag it up to 0 db.
The line should now be straight along the 0 db region.

The bass notes fall between about 40 and 180 hz. Click in the line at about 30 and 180 hz and again in the middle
of these two.



You need to make a fairly smooth curve peaking at about 12 db. This is a large bass boost. To test it click on
‘Preview’.  When it has played for a short time click on ‘Bypass’ and see what the original track sounded like.  If 
the bass is boosted too much reduce the curve by dragging on the markers that you created. When satisfied click
on ‘Add’ and type in a name, such as Bass Boost large. The next time you need to boost base you can select this
new filter that you created. You can create hundreds of them. I often remake music CDs, especially the older 60s
rock as for some reason they are produced with very poor sound. Click OK and the filter will be applied.



Don’t fiddle with any other settings until you have mastered this program as you may never get back to the 
original settings.

Your file will now look like this.



Not much different but click on the ‘Play’ button and you will hear the improvement.

All you have to do now is save it.  Click on ‘File’ then ‘Save As’, it will assume you want to save it in the folder 
that you loaded the video file from, type in a name ‘Big River boosted’ and make sure the ‘Save as Type’ is 
‘Windows PCM(*.wav)’.  You can now replace the original audio track with the new one. Close Cool
Edit/Audition and say ‘No’ to saving anything (you have already saved the new audio file).

To separate the video from the audio you now have to DeMultiplex the file as shown before.

When this is done open the video only file (Big River.mpv) in MPEG Video Wizard and drag it onto the timeline.
Not to the input window.  You then click on the ‘Files’ tab and open the new wave file ‘Big River boosted.wav’.  
This file will now show in the ‘Audio’ window on the left with a loud speaker icon and the name of the file. Drag 
this file to the audio track (the third timeline, with the violin icon). You can check the file by playing it in the
output window. If all sounds OK (and the video/audio sync is OK) click the red save button, select ‘auto’ and 
give it a new name ‘Big River New’.  Your re-edited video clip is now ready for making a DVD in TMPG Author.
Do this to any clips when you are not satisfied with the sound. You can fix up the audio in any video track with
this method except 5.1 AC3 sound, this has to be first converted to MPG sound in MPG video wizard.



If you are converting VHS tapes into DVDs and you have a very long movie (say 2.5–4 hours) you are better off
splitting it into two. To do this, record the movie with Intervideo Windvdr then open it in MPEG Video
Wizard. Simply mark in and out the first half (as described above) extract the clip (Ctrl+E) then save it (as
described above). Then move one frame forward and set the new mark in and of course go to the end and set the
mark out and save that clip. You would normally cut it at a scene change.

To make it more like a ‘real movie’ you may want to add some text to the movie where you break it.  Look at the 
screen shot below.

To insert text in a video (mainly used for your own home movies) just click on the Text icon in the tool bar (the
one with the T and pen) and the Title Editor window will appear. You can type in text and format it like in a
word processor as well as add graphics. The Slower–Faster slider is for the text display.

When you have finished you click and drag on the orange drag arrow. Drag it down to the timeline with the text
icon (the one below the film clip). You move the play marker to the position where you want the text and line up
the mouse arrow on the marker, then release the button. Put it at the end for (End of Part 1) or like the one
illustrated, at the beginning to mark the start of the second disk. You can play and pause the video in the output
window to find the exact place to insert the text. If you insert at the end the text will show on the last frame then
there will be a couple of seconds of text on blue screen (or other colour if you change it) added to the video. Little
touches like this make a professional job.



ENJOY!


